
Profiling
Getting Started

This document will teach you how to create ICC profiles using a 
combination of Wasatch SoftRIP® and a third party color profiling 
software package such as ColorBlind, Monaco, ProfileMaker, etc. We 
recommend that you allocate a minimum of 20 feet of media to produce 
each profile. 

Although this document provides a detailed discussion of how to create 
profiles using SoftRIP, you will also need to refer to your profile making 
software manual for intermediate steps where noted. Further, it will 
provide instructions for importing the profile and printing a final test 
of your new Imaging Configuration (IC). It will also cover processes for 
collecting, distributing, and installing profiles at a remote site.

Step 1: Setup Configuration
Launch Wasatch SoftRIP and select “Setup” from the Print menu.

To begin, select your Printer Model and set your Imaging Configuration 
to “none” on the Setup screen (Illustration 1a). Once you have made 
these selections, DO NOT change any settings during the profiling 
process. Changes to these settings will require starting over. Proceed as 
follows:

On the Setup screen, check Annotate Prints and the Annotation Details 
window will open. We recommend you turn on “Printer,” “Imaging 
Configuration,” “Date/Time,” and “Comment” so each image will be 
printed with your settings and additional comments.

On the Setup screen, click on the “Edit” button. This will launch the 
Imaging Configuration screen (Illustration 1b).

On the Imaging Configuration screen, click the “Properties” button. This 
will launch a control screen that provides additional settings and/or print 
modes (i.e. various resolutions, ink modes, etc.) for your printer. 

Every printer has a different set of print properties. Determine your 
intended output configuration and select from features included with 
your printer, such as: Print Direction, Print Quality, Dot Volume, Ink 
Type, Number of Passes, etc.

When you have completed your settings, click OK.

A Note Before You Start:
Always calibrate your printer before 
profiling. Follow the steps outlined in 
the printer’s user manual for printer 
calibration. In this case, calibration 
refers to the setup processes performed 
on the printer and are specific to that 
printer model (it’s not the same as 
the SoftRIP calibration described 
below). Calibration processes include 
media feed calibration, bi-directional 
calibration, head height, media 
thickness, head speed, and any other 
calibrations prescribed by the printer 
manufacturer. These settings should 
remain constant during profiling. All 
calibrations should be redone after 
loading any new substrate/material. 
In short, the printer should be in its 
optimal operating condition. 

Illustration 1a:  Setup screen

Illustration 1b:  Imaging Configuration screen
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Back on the Imaging Configuration screen, click the “Edit Info” button 
and create a text file to record the properties you selected as part of your 
configuration. This is helpful if you plan to distribute your final IC and is 
a good place to keep track of your notes as you build your IC. When you 
click “Edit Info,” your default text editor will open for you to enter notes. 
When you’re done, select “Save” from the File menu and your “info.txt” 
file will be linked to the Imaging Configuration name you select. This 
information will be available to anyone who clicks on the “Info” button 
later. You can also edit this file at any time. After saving, exit the text 
editor and you will be returned to the Imaging Configuration screen.

Step 2: Color Transforms Configuration
Click on the “Color Transforms” button to launch the Color Transforms 
screen (Illustration 2a). This is your master color flowchart screen. You 
will notice that all color data is cleared and set to none or default (as 
a result of setting IC to none). In the lower right hand corner of the 
screen, you will see that “Precision Stochastic Screens” is displayed as 
the default halftone method. For most applications, Precision Stochastic 
Screens is the preferred halftone method, and stock Wasatch ICs are 
created using them. 

However, you may choose other halftone methods from this window on 
which to build a profile. Whatever halftone method you choose will be 
incorporated into the IC you create. Changing it later will invalidate the 
Imaging Configuration. (Note: This technical document only covers 
processes for profiling with Precision Stochastic Screens. Profiling steps 
will vary for other halftone methods.)

In the “ICC Input Profile” column on the left side of the Color 
Transforms screen, you should now see all four input color spaces set to 
“System Default.” You will also see that the default rendering intent of 
“Perceptual” has been set. If your workflow includes using embedded 
profiles, check the “Use Embedded ICC Profiles” box.

Click OK to exit the Color Transforms screen and click OK again to 
exit the Imaging Configuration Screen. A “Save As” window will 
open prompting you to name your new Imaging Configuration. 
We recommend naming your “in-progress” IC with a name like 
“Unlinearized_None.” If you are making profiles in a production 
capacity, you may want to avoid having too many ambiguously named 
ICs by using a more detailed naming system like “Unlinearized_None_
resolution_inktype_media.” Once you save the IC, you will be returned 
to the Setup screen.

Step 3: Test Prints
On the Setup screen, make any other non-color related selections 
required for printing. These settings include Physical Connection, Paper 
Width, etc. Click OK and you are now ready to print your test prints.

In the File menu, select “Open” and browse to C:\psfiles and select 
the appropriate target file for your densitometry device, such as 
generalTest018eyeone.ps or generalTest018dtp20.ps (“018” is the current 
test version, but may change as new test versions become available). 
NOTE: The exact location of the “psfiles” folder may vary depending on 
the drive to which it was assigned when SoftRIP was installed.

Open one of these files and select “RIP and Print” to print the file. You 
will use it in the next section.

Note:
It is extremely important that all 
printer settings, halftone settings, inks, 
media, print modes, and other factors 
that affect the print condition be set 
prior to beginning the linearization 
process. Do not change these 
settings at all during the 
profiling process.

Illustration 2a:  Color Transforms screen
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Step 4: Determine Ink Limiting
In this step, you may decide to perform an Individual Channel Ink 
Reduction to one or more individual channels. You may also need 
to perform a Total Ink Limit, which is an adjustment to the total ink 
deposit. An Individual Channel Ink Reduction is intended to correct an 
individual ink channel or ink chemistry problem. For over-saturation 
issues, a Total Ink Limit should be applied. These are separate functions 
and are performed on different controls, as described further below.

INDIVIDUAL CHANNEL INK REDUCTION: To determine if 
you need an Individual Channel Ink Reduction, examine the color 
patches on “generalTest018eyeone.ps” or on “generalTest018dtp20.ps” 
(Illustration 4a). Individual Channel Ink Reduction is performed for 
each channel, so look at the patches for each color individually. Compare 
each color square with the one next to it. Every square should be visibly 
different from its neighbors. If two neighboring squares look the same 
and have no visible density difference, an Individual Channel Ink 
Reduction should be applied on that specific channel.

Each test pattern moves from 100% to 0% in 6% increments. No two 
patches should look like they have the same density. Locate the two 
patches with the greatest percentage that are visibly different and set an 
Individual Channel Ink Reduction equal to the percentage of the darker 
patch. Remember that Individual Channel Ink Reductions affect the 
entire color gamut, so they should be used sparingly.

If printing with diluted inks (light cyan, light magenta, light black, 
gray, light gray, etc.) and the printer is in a fixed dot mode, check the 
Fixed Dot Ink Reduction control in Halftone Properties and perform all 
Individual Channel Ink Reductions in the Halftone Properties screen 
(Illustration 4b). For all other situations, leave Fixed Dot Ink Reduction 
unchecked and perform all Individual Channel Ink Reductions in the 
Calibration screen (Illustration 4c).

Use the slider controls to set your Individual Channel Ink Reductions. 
These controls may be used for any channel individually, or for all 
channels together if the Lock box is checked. After setting an Individual 
Channel Ink Reduction, re-save your IC (named “Unlinearized_None” or 
similar) and add notes on what changes were made by using “Edit Info” 
as described in Step 1.)

TOTAL INK LIMIT: Review your print of “generalTest018eyeone.ps” or 
“generalTest018dtp20.ps” to determine if you need a Total Ink Limit in 
addition to the Individual Channel Ink Reductions you made. The upper 
right area of your test print consists of three parts.

The first part is a step pattern from 0% to 400% total ink. For your Total 
Ink Limit, you should select the highest percentage square that is dry 
and does not have print artifacts (Illustration 4d).

Note: If you are using a print mode that includes ink channels other 
than KCMY (HiFi modes), and you feel that the 400% patches are not 
sufficient, you may want to use custom-made test files. In testing, 
Wasatch noticed improved results when the Total Ink Limit was applied 
within the profiling software rather than within SoftRIP.

IMPORTANT:
There are two places where Individual 
Channel Ink Reductions can be 
performed. One or the other will be 
used depending on the inkset being 
used or the dot mode being used. 
Never use both at the same time.

Illustration 4a:  Color patches from 
‘generalTest018eyeone.ps’ or ‘generalTest018dtp20.ps’

Illustration 4c:  Calibration screen
(Print>Setup>Edit>Color Transforms>Calibration)

Illustration 4d:  Total Ink step pattern

Illustration 4b:  Halftone Properties screen
(Print>Setup>Edit>Color Transforms>Halftone Properties)
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The second part is a series of open boxes consisting of composite blacks. 
Check this area for media bleed, over spray, and resolution issues 
(Illustration 4e).

The third part is a series of three rows of swatches located below the 
boxes of black lines. These swatches consist of primary inks and one 
CMY black at the upper-right corner (circled in Illustration 4f). The CMY 
black may show excessive bleeding or artifacts due to the “inks mixing” 
where the first two tests above do not. This is why it’s very important to 
review this patch. Check this area for individual channel ink retention 
issues (Illustration 4f).

Again, if there are issues with any of these test patterns, you’ll need to set 
a Total Ink Limit or return to the Individual Channel Ink Reduction step 
to apply stronger reductions. If you choose to set a Total Ink Limit, return 
to the Color Transforms screen (Illustration 2a). Above the Halftone 
Properties on the right side, you’ll see the Ink Limit (Total Percent) box. 
Enter the percent of your Total Ink Limit, click OK to exit the Imaging 
Configuration screen, and save your “unlinearized” IC. Click OK to exit 
the Color Transforms screen, click OK to exit the Imaging Configuration 
screen, and save your “unlinearized” IC.

Step 5: Test Print
Reprint your test file (“generalTest018eyeone.ps” or 
“generalTest018dtp20.ps”) to check for any additional Individual 
Channel Ink Reductions or Total Ink Limits that may be required. All 
squares should have good retention, show no artifacts, and have no 
bleeding problems.

If you are still having ink retention issues, depending on the printer 
model, there are other options that can be used for limiting ink. For 
example, you can choose a different ink set (i.e. CMYK, CMYKLcLm, 
etc.), lower the resolution, or change to a dry mode (if available).

Note: If you make any changes to the setup configuration, you will 
need to restart the profiling from Step 1.

Step 6: Linearize (Calibrate) the Printer
Open the appropriate linearization file that matches your 
spectrophotometer and printing scenario, such as c:\wwrip\psfiles\
DTP41.ps or c:\wwrip\psfiles\DTP32.ps. You can find more information 
on which file to use for your spectrophotometer in the Densitometers 
section of SoftRIP’s online help.

RIP and Print the selected linearization test pattern.

Return to the Calibration screen (Illustration 4c) and click the Calibration 
Curves button to launch the Calibration Curves screen (Illustration 6a).

Use the “Options” menu on this screen to choose between performing 

Note:
Be aware of the amount of drying 
time needed before the patches can 
be handled in this step because this 
may imply that you should do further 
ink limiting. This is an individual 
preference and is determined by what 
drying time would be acceptable in a 
production environment.

Note:
If you have set a Total Ink Limit, all 
patches above the percent set will be 
identical. For example, if you set your 
Ink Limit (total percent) to 325%, you 
will see that the patches for 325, 350, 
375, and 400 all look the same.

Note:
If your spectrophotometer is the DTP20 
or the Eyeone, the test file already 
contains the linearization pattern and 
does not need to be printed again.

Illustration 4f:  Swatches consisting of primary inks and 
CMY black

Illustration 6a:  Calibration Curves screen

Illustration 4e:  Open boxes with composite blacks
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a density linearization (default) and a dot linearization. Your choice 
should be driven by your output type and, more importantly, by the 
expectations of your ICC profiling software. You may need to test each 
setting to determine which provides best results with your profiling 
package.

Select your densitometry hardware from the “Densitometers” menu. 
You will receive device-specific instructions for reading the linearization 
patches. Once you have followed the on-screen instructions and have 
read the test patterns/strips, click OK to exit.

You will see the resulting data in the Calibration Curves display, which 
will look similar to the curves shown in Illustration 6b. Click on OK 
as many times as is necessary to return to the Imaging Configuration 
screen. 

You must exit all screens by clicking OK, instead of Cancel, or your 
data will be lost. 

When you click OK on the Imaging Configuration screen, you will be 
asked to save your Configuration. Name your Configuration so that it is 
identified as your original linearization data.

Step 7: Confirm Linearization
Reprint the same linearization test pattern from Step 6 using your new 
Imaging Configuration. If you used one of the “generalTest018” files, you 
can reprint it again. By reading these new patches, you can double check 
your linearization to ensure that your original data is good. 

Open the Calibration Curves screen. Use the “Options” menu to select 
the same linearization type used in the original linearization. Select your 
hardware from the “Densitometers” menu again and follow the steps to 
read the linearization patches.

When asked if you want to overwrite or add the new curves to the 
linearization, choose “Yes.”

Now the curves shown in the Calibration Curves display should look 
nearly linear (straight on the diagonal). If your curves look linear, as 
shown in Illustration 7a, you need to use the Cancel button to back out of 
all screens and return to the main screen. 

NOTE: Do not use the OK button. It is very important that 
you use Cancel to exit; if you use OK, you will write over your 
data and invalidate the linearization.

If your curves do not look linear, have large bumps, or fall sharply away 
from the center line, you’ll need to perform a new linearization. To do 
this, you must first clear out your linearization curves by using “Clear 
All” from the top menu. 

Use OK to back out of the Calibration, Color Transforms, and Imaging 
Configuration screens and resave your Imaging Configuration with a 
new name (such as Linearization_Second_Attempt) and click OK to save. 

Return to Step 6 to perform a new linearization and repeat the steps to 
confirm linearization. If the curves still have bumps or fall away from 
the centerline after the second confirmation, you should reconsider your 
Total Ink Limit and Individual Channel Ink Reduction settings. You may 
want to speak with a Wasatch technician for guidance.

Illustration 6b:  Calibration Curves display

Illustration 7a:  Confirm linearization in the Calibration 
Curves screen
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Step 8: Print Profile Target
The profiling software (such as Monaco or ColorBlind) you are using will 
provide a standard set of patches that will need to be printed through 
SoftRIP and read with your spectrophotometer. 

Open the file provided by your profiling software in SoftRIP. Now, with 
your newly created linearized Imaging Configuration applied, RIP and 
Print the file.

Allow the patches to dry (if necessary) and scan the patches into your 
profiling software. Save the generated ICC or ICM file to a location you 
can easily browse for importing into SoftRIP.

Note: If you are working in a HiFi print mode and your profiling 
software applies a curve to the Spot Colors, we recommend that you 
modify the default curve so that it is linear for each Spot Color.

Step 9: Import Profile
Once the profile has been generated from the profiling software, you can 
import it into SoftRIP and match it to the linearization by accessing the 
Color Transforms screen (Illustration 9a).

In the middle section, you’ll see the “Output ICC Profile” section. It 
should still show “None” as the profile. Browse for the correct “ICM” 
or “ICC” file in the directory where you saved the profile from your 
profiling software. The arrows on the Color Transform screen should 
turn green, indicating that the color workflow is working correctly with 
an output profile in place.

Click OK until you get to the “Save As” screen. At this point, you want 
to save the Imaging Configuration under the final name you want your 
profile to have. We recommend using the “Resolution_Inkset_Media” 
naming convention, to make it easy to find the Imaging Configuration 
later. When you click OK, your configuration will be saved. Your 
new Imaging Configuration can now be accessed from the Imaging 
Configuration pull-down menu on the Setup screen.

Step 10: Print Profile Test
With your new profile, you may want to print a test file. Wasatch does 
not supply a file for you to use, but we suggest you create one internally 
as a final standardized testing procedure.

This test file should be one in which the original color is standardized. 
We recommend that you DO NOT use a customer file or a random color 
file as it will be difficult to locate color issues in these types of files. 
Rather, Wasatch recommends that you print a standard image you are 
familiar with. It should have primary colors, secondary colors, and an 
image with details like faces, shadows, etc. It should also have both 
CMYK and RGB components (Illustration 10a).

Be sure that all of your color and printer settings are consistent with the 
settings you used when your profile was generated. RIP and Print your 
test image.

Analyze the print for quality assurance in order to determine whether 
your new profile should pass or fail. Things to check for include: 
posterization, lizarding effects, turtling effects, bleeding, banding, 
patterns introduced by process, and any other abnormalities. Also check 
the final print for saturation and overall color. Keeping in mind that 

Illustration 9a:  Color Transforms screen
(Print>Setup>Edit>Color Transforms)

Illustration 10a:  Profile test
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different substrates (media) will look different, it is reasonable to ask, “Is 
this expected behavior for the media and resolution?”

Step 11: Distribution (optional)
If you intend to distribute profiles, you must be in accordance with the 
copyright statement of your profiling software.

We recommend that you distribute your new Imaging Configurations 
using our automatic installer. In order to work with the Wasatch 
installer, you must gather all of the files associated with the new 
Imaging Configuration into a folder that is called “configurations” 
(case sensitive). 

We recommend you put your working “configurations” 
folder in a temporary location for gathering the files, such as 
c:\temp\configurations.

Go to c:\wwrip\configurations and find the folder with the name of the 
printer model used in your profile (Illustration 11a). There are separate 
folders for each of that printer’s installed Imaging Configurations within 
the printer folder (Illustration 11b). 

For distribution, you need your new profile to be in a folder named 
precisely like this printer’s folder (case sensitive, all spaces included, 
etc.). For this reason, we recommend that you copy the entire folder 
named for that printer over to your temporary “configurations” folder 
and then delete all the imaging configuration sub-folders other than the 
one you wish to distribute from the temporary location.

You can find the automatic installation tool on the Imaging Configuration 
CDs provided with SoftRIP. From the CD, copy “Install.exe” and the 
“Autorun.inf” informational text file to your temporary folder. 

NOTE: The files “Autorun.inf” and “Install.exe” should be one level 
down from the configurations folder. Now you can email or burn the 
new configurations to CD for distribution.

At the distribution site, the customer can launch “Install.exe” by double 
clicking the file. If distributing by CD, the “Autorun.inf” file will 
automatically launch the installer when the customer inserts the CD. The 
installer will ask for the location to copy the Imaging Configuration(s) to. 
The primary wwrip folder should be selected (such as c:\wwrip). 

The installer will list all Imaging Configurations, by printer, that are in 
its same “configurations” folder. To install, a user only needs to check 
the boxes for the desired profiles. A confirmation message will be shown 
with the number of profiles installed. Here, the customer can Click OK 
and Exit.

Your new profile will now appear in the user’s copy of SoftRIP. When 
the appropriate printer is selected in the setup screen, the new Imaging 
Configuration will appear along with others loaded in the Imaging 
Configuration window.

Illustration 11a:  Your c:\wwrip\configurations folder 
will look something like this

Illustration 11b:  Imaging Configurations within your 
chosen printer folder

ColorBlind, Monaco, and ProfileMaker are all trademarks or registered trademarks of their respective owners.


